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Preface

This document details the preparation required on the Exchange 5.5 Directory Service prior to replicating to the AD, which is part of the Platform 2000 infrastructure. 

This information will enable technically knowledgeable people to design the implementing of this element for their business unit.

Although background information has been referenced throughout the document, this design document provides little “concept overview” and therefore assumes that the audience has a good understanding of the base concepts associated with preparing the Exchange 5.5 DS.

Readers who wish to gain an understanding of the implementation and management associated with Exchange 5.5 DS preparation should refer to Section 1.4 Associated Documents, page 2.  

Conventions

The architecture is described in terms of standards and guidelines:

[image: image13.png]Mandatory standards are used where it is necessary to have a common setting across the   Enterprise. They are indicated by the symbol on the left. The business unit implementing this particular design element will be required to use the standard as defined in this document.
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Guidelines are indicated by the symbol on the left. These guidelines will provide details of configurations options that can be tailored to meet individual business unit level needs. This document provides details of the available options and guidance on how to select an appropriate option.  

Abbreviations Used in the Document

	ACL
	Access Control List

	AD
	Active Directory

	ADC
	Active Directory Connector

	BU
	Business Unit

	CA
	Connection Agreement

	CET
	Corporate Exchange Team

	CSV
	Comma separated values

	DL
	Distribution List

	DS
	Directory Service

	E2KRSK
	Exchange 2000 resource kit

	GAL
	Global Address List

	HR
	Human Resources

	MAPI
	Messaging Application Programming Interface

	NTDS
	NT - Directory Service as used in NTDSNomatch

	P2K
	Platform 2000

	PF
	Public Folder

	RE
	Reed Elsevier

	RE
	Reed Elsevier

	SMTP
	Simple Mail Transport Protocol

	TLPF
	Top Level Public Folder

	UDG
	Universal Distribution Group


1 Design Information

In order to facilitate interoperability between Exchange 2000 and Exchange 5.5, Exchange 2000 will be introduced in mixed mode. Prior to establishing this interoperability it is necessary to ensure that data to be migrated into the Active Directory meets the defined standards.

The purpose of this document is to describe those tasks required for Exchange 5.5 site administrators to firstly identify and secondly migrate the data into the required formats.

1.1 Assumptions

It is assumed that Exchange 2000 will be introduced in mixed mode, allowing for the interoperability of existing Exchange 5.5 sites.  It is also assumed that Active Directory will be deployed in native mode per the high level design.  

1.2 Requirements

The requirements for implementing changes recommended in this document to the existing RE Exchange 5.5 organization are the following:

· Appropriate permissions within the Exchange 5.5 site including Permissions Administrator

· Change control announcements prior to any change that effects edits to the GAL, PF tree, permission on objects, locations of objects, and renaming of objects.

· Thorough understanding of Exchange 5.5 and resources cited in this document.

· Complete, full backups of any site server where changes are to commence as a result of recommendations found in this document.

· Proper scheduling with pertinent change control committees, management and end-users where applicable.

1.3 Technical Environment

Reed Elsevier’s current Exchange 5.5 organization is composed of nearly 80 sites containing one or more servers providing message storage, public folders, and bridgehead servers.  

The installation of Exchange 2000 in mixed mode will allow the continued operability with existing Exchange 5.5 sites by way of synchronization between the Exchange 5.5 Directory Service and the Windows .NET Server Active Directory service using the Active Directory Connector, which uses connection agreements to pass information between the two directories.  

Limitations in the functionality of the ADC CA make it essential to clean up the Exchange 5.5 directory in order to provide seamless interoperability between both messaging systems and continued use of public folders.  This document outlines the clean-up steps required in the existing RE Exchange 5.5 organization for the successful co-existence of Exchange 2000 and Exchange 5.5 during the Exchange mixed mode environment.

1.4 Associated Documents

P2K-62 Standard: Object Naming
P2K-689 Design: Exchange 2000 Public Folder
P2K-692 Design: Active Directory Connectors
Exchange 2000 and Exchange Server 5.5 Public-Folder Interoperability, Kieran McCorry

2 Prepare the Exchange 5.5 Directory

The ADC CAs synchronizes the Exchange 5.5 DS with the Windows .NET Server AD.  The purpose of this synchronization between directories is to allow messaging between the two messaging systems to occur in a seamless fashion.  

Global Address Lists in both directories will reflect the combined total messaging community within the Reed organization. 

Several clean-up steps in the Exchange 5.5 directory are required before installing the ADC and creating the first CA.  

2.1.1 [image: image15.wmf] 

Invalid Characters in OrganizationName

Certain characters in use currently in the Organization name of Exchange 5.5 are not allowed by the ADC.  Currently, most sites show Reed_Elsevier which translates to Reed?Elsevier in the x400 naming context.  The hyphen is allowed, and can replace the underscore.

Use the properties of the Org name to rename the object from Reed_Elsevier to Reed-Elsevier as shown in Figure 1:
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Figure 1: Renaming from Reed_Elsevier to Reed-Elsevier

While this will affect the way in which the name is shown in address book views and within the administrator application for 5.5, it will not affect the existing X400 naming for e-mail addresses or newly created e-mail addresses.  The name used there is taken from the directory, which cannot be changed after the fact. However, to make it possible to use the name with the ADC, this change must be made.
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Invalid Characters in Site Names

Exchange 5.5 organization and site names contain characters that are not supported by Exchange 2000.  These objects will have to be renamed.

Organization and site display names can contain only the following characters (all other characters are invalid):

A-Z

a-z

0-9

- (hyphen)

Spaces are also valid. However, remember that parentheses“( ),” and brackets, “[ ],” cannot be used.

Site names are housed in the Exchange 5.5 directory, and objects pertaining to the original site name are created there.  These entries cannot be renamed. However, the element that the ADC relies upon, the display name, can be renamed.  

If your site does not contain valid characters as described above, rename the site using the properties of the appropriate site within the Exchange Administrator.

New sites should adhere to the AD site naming standard as detailed in P2K-62 Standard: Object Naming.
2.1.3 Distribution List Naming

Distribution lists as used by Exchange 5.5 need to be renamed in accordance with the Exchange naming standard.  If a DL has to be renamed, this can be done with the coordination of the users belonging to the DL without difficulty.  Support centres should retain a history of all renamed DLs in the event users miss or forget announcements of DL names changing.  
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DLs in Exchange 5.5 will be converted to UDGs or mail-enabled groups.  It is important to rename these groups per the naming standards document cited below.

Please refer to document P2K-62 Standard: Object Naming when renaming UDGs.

2.1.4 Anomalous Objects and Resource Mailboxes

Microsoft makes recommendations for successful use of the ADC tool which essentially state that shared mailboxes in Exchange 5.5 must be re-ACLed.  The following excerpt from the E2KRSK explains:

An anomalous object is defined as an Exchange 5.5 mailbox whose mailNickname attribute (Exchange 5.5 alias) does not match the loginID attribute of the primary Windows security account associated with it in the same domain.

These mailbox objects or resource mailboxes are usually associated with a resource, such as a conference room, or a common HR mailbox used by all members of HR. In other words, an Exchange 5.5 resource mailbox object with the mailNickname X may have its primary Windows user attribute set as Windows user loginID Y. However, the Windows user Y also has an Exchange 5.5 personal mailbox called Y, resulting in two Exchange 5.5 directory objects with the same primary Windows security principal.

If a mismatch is not cleaned up before the first ADC replication, the ADC can link the wrong primary Windows security principal to the mailbox.  The NTDSNoMatch utility, also known as NTDSAtrb, can be used to identify anomalous and resource mailboxes and stamp the custom attribute 10 with NTDSNoMatch.  (Refer to Section 3.11 The Active Directory Connector Overview, page13 later in this document for an overview of this tool.)
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In order for the NTDSNoMatch utility to function, e-mail administrators must ensure that Custom Attribute 10 within all mailboxes is unused.

The following excerpt from Microsoft’s Connecting Active Directory to Exchange 5.5 describes how the ADC deals with resource mailboxes in Exchange 5.5

If multiple mailboxes are linked to one user account, then ADC will first process the one closest to the start of the alphabet, according to the three options above. When the ADC processes the second mailbox associated with the Windows NT account, it will find an existing user account in Active Directory that is already mapped to a different mailbox. So the ADC will then create a disabled user account with the name of the second mailbox. The two mailboxes in Exchange 5.5 that mapped to the one Windows NT account now become two separate mailbox-enabled user objects in Active Directory, one of which will be accessible by the user, the other (the newly-created one) won’t.
The point here is that this happens on an alphabetical basis. So you would use NTDSNoMatch to control which mailbox is associated with the Active Directory account for that user, and which one creates the new disabled account. 

When single mailboxes are linked to multiple user accounts, there is also the problem in that the ADC might process the shared mailbox before the user’s primary mailbox. The ADC will then mailbox-enable the user account in Active Directory and link it to the shared mailbox rather than the user’s mailbox. With shared mailboxes, you also want the ADC to create a new, disabled user account for the shared mailbox.”

Hence, all shared mailboxes must be assigned a dedicated user account before the ADC CA implementation.  Although this will result in additional user Ids, it will prevent the problems noted above.  The user ID created and applied as primary account should be named to represent the resource.

The alias referred to above in the discussion about anomalous accounts refers to the fact that during migration by way of BVMigrate the alias in Exchange 5.5 is used as the name of the newly created AD account.  Despite this scripts will be made available to correct the new account name to one that conforms to P2K object naming standards.  Hence it is not necessary during cleanup to alter alias names if changing the alias presents a problem for users such as those who use Outlook Web Access.

Using NTDSNoMatch

To resolve these problems, you must document any mailboxes with multiple user accounts and user accounts with multiple mailboxes. If you do not already have this documentation, then you could use the NTDSNOMATCH utility to search your Exchange 5.5 directory to find such mailboxes. 

For information about installing and using NTDSNOMATCH, please refer to the following article in the Appendix A.6.

To avoid problems, you should customize the appropriate mailboxes in your Exchange 5.5 directory prior to installing the ADC. The solution is to add the text NTDSNoMatch to custom attribute 10 of a mailbox. When the ADC sees this value, it will not attempt to associate the mailbox with an existing user account and will create a new, disabled user account. The NTDSNoMatch utility can help to automate this process.

2.1.5 Recipient Containers

Because a Migration OU is used for the ADC CAs, no restructuring of recipient containers will be required.  All restructuring of OUs will occur in AD.

2.1.6 Preparing Exchange 5.5 Rich Information

It is best practice, before ADC implementation, to prepare the Exchange 5.5 DS objects to conform to naming conventions, including titles, country abbreviations, phone formats etc. that are housed within the DS.  This information is referred to as Exchange 5.5 rich information.

The tool of choice for making alterations or additions to the Exchange DS object en masse is the import/export tool found in the Exchange Administrator program in combination with the Header.exe tool found in the Back Office Resource Kit.  

These tools are discussed in Section 3 Implementation Planning, page 13.  The header tool allows for the creation of templates used for import that contain object classes not found in the default template used by Exchange administrator.  These objects can be composed of SMTP addresses, for example, not found using the Export tool CSVs.

Refer to Appendix B for a list of object mappings between Exchange 5.5 DS to AD.

Not many sites have populated all Exchange DS attributes or have done so without regard to a standard.  P2K-62 Standard:Object Naming contains details on how to prepare the Exchange 5.5 DS entries to conform to the P2K initiative for naming standards, and is in the “User Account Attributes” section.  This document also outlines naming standards for elements that can be found in object classes of the DS such as geographic naming standards.

Figure 2 and Figure 3 are taken from the mailbox creation panels in Exchange 5.5 Administrator and use a sample of required data from the P2K-62 Standard:Object Naming .  Refer to this document for required fields.
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Figure 2: Mailbox General Properties
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Figure 3: Mailbox Phone/Notes Properties

2.1.7 Multiple SMTP and Foreign Addresses

SMTP Addresses

Many sites with the RE Exchange 5.5 organization may be using multiple SMTP addresses for several reasons such as preserving previously used SMTP addresses from earlier messaging systems, maintaining a point of presence on the Internet, or making additions as a result of an acquisition.  

These addresses must be reduced to the smallest number necessary and standardized to suit the P2K initiative and needs of the business unit. Use of the Header.exe tool in combination with the Exchange 5.5 Import/Export tool can simplify making these changes.

Many sites with the RE Exchange 5.5 organization have been upgraded from a previous mail systems resulting in foreign addresses such as GroupWise addresses, legacy fax connector addresses, etc. that may be now obsolete and unused but are still found within the properties of the Exchange 5.5 mailbox.  These must be cleaned or removed prior to the first ADC implementation.  

Note 

Unused valid SMTP addresses can lead to more unwanted spam.

2.1.8 Public Folder Hierarchies

The current public folder hierarchies within the RE Exchange organization have gone largely unchecked since the inception of Exchange 5.5, resulting in an inordinate amount of inappropriately placed Top Level Public Folders.  The PF hierarchy will have to be restructured in order to accommodate the Exchange 2000 migration.

Please refer to  P2K-689 Design: Exchange 200 Public Folder for details of the public folder strategies for Exchange 2000.

2.1.9 Restructuring Public Folders

Top level folders should follow the RE Exchange Admin Handbook guidelines.  This excerpt from the handbook describes the preferred TLPF tree:

- Public Folders 

+ Favorites 

- All Public Folders 

+ 1 Reed Elsevier Information 

+2 Business Unit Information 


+ Cahners Business Information

+ Elsevier Science

+ LEXIS-NEXIS 

+ Reed Business Information

+ Harcourt Education 

The first step in maintaining your PFs is to disallow the creation of top-level folders via the Exchange admin tool by populating the permissions with appropriate users and or groups.  

The default setting in Exchange 5.5 to allow anyone within the site to create TLPFs, because the permissions shown for this setting are blank by default.  Within the Exchange administrator, use the Information Store Site Configuration Properties property sheet to adjust appropriate permissions for TLPF creation.  Find this item by double clicking or expanding the Configuration object and highlighting the information store site configuration properties as shown in Figure 4:
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Figure 4: Adjusting permissions for TLPF creation

Public folders may have to be moved in your site to accommodate the Exchange 2000 migration.

Public folders can be moved using drag and drop methods within a MAPI client such as Microsoft Outlook.   

Essentially, a primary mouse click and drag will copy by default the folder into the new location where a secondary click and drag will prompt for action to be performed on the folder (see Figure 5):
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Folder is highlighted and dragged
	
Once dragged to new location, secondary mouse is released and prompt for action to perform is displayed.


Figure 5: Moving a public folder from one location to another

Note that

Moving the folder must be done in cooperation with users of these folder, because hyperlinks will no longer function and users will not necessarily know where to look for the folder.

Moving folders creates replication traffic and should be done in smaller increments during non-production hours to prevent interfering with normal business operation.

Refer to the table below for help in finding the appropriate resource in aiding your restructuring of Exchange 5.5 Public Folders:

	Topic:
	Title
	Q article Number

	Re-home PFs
	XADM: How to Re-home Public Folders Using 5.5 Admin Program
	Q185043

	Exporting PF data
	XADM: How To Export Public Folder Directory Data To A CSV File
	Q185018


Refer to Section 3 Implementation Planning, page 13 for information on PF tools available for Exchange 5.5

2.1.10 Re-Homing Public Folders

Re-homing public folders can be achieved in several ways, one shown in the appendix A.4 and the other here.  Re-homing relocates the data from one server to another either in the same site or another site.

Within the Exchange Administrator 5.5 application proceed to the public folder resources as shown in the screen cap below:
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Figure 6: Public Folder Resources
Locate the public folder that needs to be re-homed and view its properties as shown below.
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Figure 7: Public Folder Replica

In order to use the advanced tab to re-home a public folder it must first have a replica on the destination server.  Depending on the size of the PF you may need to wait for replication to occur prior to re-homing.  Below is a figure showing the advanced tab where re-homing PFs can be performed.
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Figure 8: Public Folder Advanced Re-Homing

Within the advanced tab the Home Server can be chosen.  The list available of severs reflects all servers where replicas have been established.

2.1.11 Public Folder ACLs

Access control lists on the public folders must be examined. If any obsolete accounts exist in a public folder, Exchange 2000 will not be able to resolve these names to the AD and access to that PF is blocked for Exchange 2000 users.  

Each public folder must be carefully inspected to insure the ACLs are accurate and up to date.  

To remove unknown or obsolete permissions from the PF, use the Site | Server | Properties | advanced properties | consistency adjuster property sheet and check the tick-box Remove unknown users accounts from public folder permissions as shown Figure 9:
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Figure 9: Removing permissions from the PF

Warning:  

Inadvertently checking the “ Synchronize with the directory, and reset the home server value for public folders homed in unknown site…”  check box in the panel can result in incorrect PF permissions.  Refer to Appendix A. 

3 Implementation Planning 

3.1 Available Tools

Microsoft provides several tools to help to prepare for the installation of Exchange 2000.  This section describes tools available for achieving the requirements stated in this document.

3.1.1 The Active Directory Connector Overview

The ADC will be used to replicate Exchange 5.5 DS contents to AD by use of connection agreements or CAs.  The purpose of the ADC is to allow a mixed environment of Exchange 2000 and Exchange 5.5 to co-exist by synchronizing the Exchange 5.5 DS information with the Windows .NET Server AD.  The ADC will propagate Exchange 5.5 Rich Information to the AD, which is the basis for this clean-up document.  

Please refer to P2K-692 Design: Active Directory Connectors for details of the implementation of the ADC.

Table 1 shows matches that occur at an object level for the two directories.

Table 1: Matches between Active Directory and Exchange 5.5 objects
	Active Directory Object
	Exchange Directory Service Object (in the Target Container) 

	Mailbox-enabled user
	Mailbox 

	Mail-enabled contact
	Custom recipient 

	Mail-enabled user
	Custom recipient 

	Mail-enabled group (type: distribution)
	Distribution list 

	Mail-enabled group (type: security)
	Distribution list 



Before the objects detailed in the table above are replicated between the directory services it is important that the existing objects in Exchange 5.5 are first edited to conform to P2K’s naming standards.

3.1.2 NTDSNoMatch

The following excerpt is taken from Q article Q274173 XADM: Documentation for the NTDSNoMatch Utility.  Please refer to this article for a complete description of using this tool.

When you use the Active Directory Connector (ADC) to synchronize a Microsoft Exchange Server 5.5 organization with Active Directory, and you have multiple mailboxes with the same primary Microsoft Windows NT account, you can control how the ADC matches the mailboxes to Active Directory user accounts. 

In Microsoft Exchange 2000 Server, unlike Exchange Server 5.5, a mailbox is an attribute of an object in Active Directory, not an object itself. Therefore, each user object in Active Directory can only be matched to one mailbox. For every mailbox that exists in the information store, a matching object must exist in Active Directory. This difference allows you to retain the permissions set directly on the mailbox object, such as delegate and additional mailbox owner permissions. 

By default, the ADC creates disabled users in Active Directory if it cannot match a mailbox to a user. Additionally, a custom attribute can be set on the mailbox to force the ADC to create a new object instead of matching it to an existing user. To do this, set Custom Attribute 10 to NTDSNoMatch . When you set this attribute on resource-type mailboxes, ADC is able to match a mailbox that does not have the NTDSNoMatch option set to the correct user account. 

The NTDSNoMatch utility can be used to help perform this task. It checks for mailboxes with a duplicate primary Windows NT account, and determines if the mailbox is the primary mailbox or a resource mailbox. Then, it creates a comma-separated value (.csv) file, that you can import into the Exchange 5.5 directory. This file automatically sets Custom Attribute 10 to NTDSNoMatch for the resource mailboxes.
3.1.3 PFINFO

The Microsoft Exchange Public Folder Information Program (PFInfo.Exe) is a program that extracts information about the Public Folders in a Microsoft Exchange Site.  It can be used to extract the following information to the delimited output file. 

1. Folder Name 

2. Folder Path 

3. Permissions 

4. List of Public Folder Replicas 

5. Number of Replicas of the Public Folder 

6. Number of Items in the Public Folder 

7. Size in KiloBytes of the contents of the folder, not including sub-folders 

8. Age Limit 

9. Replication Message Priority 

10. Replication Schedule 

11. Alias 

12. Storage Limit (K) 

13. Date the Public Folder was Created 

14. Date the Public Folder was last modified (As seen in the Exchange Administrator program) 

15. Home Site 

16. Home Server 

17. E-mail Addresses

Refer to Q article Q261093, XADM: Readme Document for the Pfinfo.exe for detailed information on using this tool found in Appendix 3.

3.1.4 Exchange 5.5 Import/Export Tool

This tool is found in the Exchange 5.5 Administrator and is used to output CSV files for editing and re-importing into the Exchange 5.5 DS.  

Not all objects, however, are included in the basic template used by the Exchange administrator.  To enhance the functionality of this tool, the Header.exe tool can be used to create templates for inclusion of object classes not provided by the Exchange Administrator tool.  

Figure 10 shows the options available using the Exchange Administrator Export tool found in Tools menu:
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Figure 10: Options available on the Tools menu of the Exchange Administrator
This tool allows you to export based on criteria including mailbox, custom recipient, and DL.  

The CSV file can be edited using MS Excel or Notepad, and then re-imported.  

See  Appendix A.5 for information about using CSV files for imports and exports of data from the Exchange 5.5 DS.

Caution 

Use extreme care when using Excel to sort or manipulate data.  

Always preserve original CSV file and work from a copy in case, a back-out is required!  

In many cases, the search and replace functionality of MS Notepad will be sufficient.
3.1.5 Exchange 5.5 Header Tool

The Header.exe tool is in the Back Office Resource Kit 4.5 and is used to create template CSV files for the purpose of importing or exporting.  

This tool must be run from the Exchange server in order to connect to the DS directly.

Figure 11 shows the capabilities this tool offers when you need to make mass changes or additions into the directory:
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Figure 11: header.exe

As with all changes en masse made to the DS; it is wise always to keep a copy of the original DS exported to a CSV in case things go wrong!  

Never edit your original exported CSV:  instead, copy it to a newly named file and work with it, not the original.

3.1.6 GALMOD

GALMOD is a sample utility available from Microsoft that can access the Exchange 5.5 DS via a web page allowing users to edit their own Exchange 5.5 rich information.  RBI-US implemented a form of this utility that has proven to be helpful in ensuring Exchange rich information is up to date.  Here’s an excerpt from Brian Waldron’s original documentation on the use of GALMOD:

“The principal components of the application are the intranet Web Server, an Exchange Server containing the GAL, and an Exchange Server containing an individual's Employee Directory record. Principal technologies are ASPs, ADSI, ADO (Active Data Objects, a streamlined wrapper for ODBC database connections), and LDAP (Lightweight Directory Access Protocol), which is the underlying directory-access protocol used to communicate with Exchange.

Much of the Directory Update code is derived from a Microsoft example named GALMOD - Global Address List Modify - from the Back Office Resource Kit. In addition, functions that enable users to search the GAL for employee information were adapted from an earlier Cahners development project; these search functions are also based on GALMOD. The search functions are described separately later in this document.” – Brian Waldron
If you are interested in allowing users to edit their own rich information and are interested in the use of GALMOD please contact either MS or the CET who will be able to direct to the appropriate resources.


3.2 Summary

Clearly, much must be done with the existing Exchange 5.5 directory before the introduction of Exchange 2000 and Active Directory.  This may seem daunting, but not attending to it now can compromise the quality and usefulness of the Windows .NET Server implementation.  

Assistance will be made available either by direct involvement of the P2K team and/or existing facilities such as the RE CET.

Appendix A   Microsoft Q Articles 

The following are Microsoft Q articles referenced in this document.  They are reprinted without permission from MS but we’ll see if they have problems with it …

A.1
How to Move a User to a Different Recipient Container (Q160179)


The information in this article applies to:


Microsoft Exchange Server, versions 4.0 , 5.0 , 5.5 


SUMMARY

There is no built-in utility to move a user from one recipient container to another. To move a user from one recipient container to another: 

1. Make sure the user has all his or her mail in a local .pst file. Also make sure that if the user uses Schedule+ he or she also has a local Schedule+ file. 


2. Delete the user and then re-create the user in the recipient container that you want the user to be in. 


MORE INFORMATION

An alternative way to move a user from one recipient container to another: 

1. Export the user into a .csv file and then delete the user. 


2. Import the user into the proper container. 


This method saves you the step of having to re-create all the user's information. A complete CSV file with all possible headers can be found on the Exchange Server CD under Support\Samples\Csvs\Mailbox\Mailbox.csv. Exporting to this file will ensure that all attributes are preserved. You still have to manually move mail to local .pst and Schedule+ files. 
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A.2
How to Move a Distribution List to a Different Recipients Container in a Site (Q258738)


The information in this article applies to:


Microsoft Exchange Server, versions 4.0 , 5.0 , 5.5 


SUMMARY

There is no built-in utility to move a user from one recipient container to another. To move a user from one recipient container to another: 

1. Make sure the user has all his or her mail in a local .pst file. Also make sure that if the user uses Schedule+ he or she also has a local Schedule+ file. 


2. Delete the user and then re-create the user in the recipient container that you want the user to be in. 

MORE INFORMATION

An alternative way to move a user from one recipient container to another: 

1. Export the user into a .csv file and then delete the user. 


2. Import the user into the proper container. 


This method saves you the step of having to re-create all the user's information. A complete CSV file with all possible headers can be found on the Exchange Server CD under Support\Samples\Csvs\Mailbox\Mailbox.csv. Exporting to this file will ensure that all attributes are preserved. You still have to manually move mail to local .pst and Schedule+ files. 
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A.3
Moving Mailboxes to a Different Recipient Subcontainer (Q231461)


The information in this article applies to:


Microsoft Exchange Server, versions 4.0 , 5.0 , 5.5 


SUMMARY

This article describes how to move mailboxes to a different recipient subcontainer and to change the name of a recipient subcontainer or container. 

NOTE : If you delete a mailbox in the original container, and then create a new mailbox with the same name in a new container, the messages in the old mailboxes are destroyed permanently. 

MORE INFORMATION

By design, when you use the Move Mailbox functionality in the Microsoft Exchange Server Administrator program, you cannot move a user to a different container on the same server or a different server within the same site, and you cannot move the user to a different site. 

For additional information, click the article number below to view the article in the Microsoft Knowledge Base: 

Q160179 XADM: How to Move a User to a Different Recipient Container 

To move any number of mailboxes (for example, mailboxes from an entire department to a new subcontainer) and to change the name of a subcontainer: 

1. Start the Administrator program, and then click Directory Export on the Tools menu to export the individual subcontainer using either a custom .csv file created by Header.exe or using any of the following .csv files from the Exchange Server 4.0 CD-ROM: 


Mailbox.csv (for mailboxes only) 


Custom.csv (for custom recipients only) 


Dl.csv (for distribution lists only) 


2. Perform step one of the two-step Exmerge process to export the mail for the users in the subcontainer to individual .pst files. 


3. If you are moving all the users in the subcontainer, delete the recipient subcontainer. If you are moving only part of the mailboxes out of the subcontainer, delete only the mailboxes within the subcontainer. 


4. In the Administrator program, click the Exchange Server computer name, double-click the directory service in the right pane, and then click Update Now . 

Make sure the deletion has replicated throughout the site. 


5. If the new subcontainer does not already exist, use the Administrator program to create the subcontainer or new container. 


6. Edit the .csv file to change the name of the recipient subcontainer. 


7. On the Tools menu, click Directory Import , and then use the .csv file to import the mailboxes into the proper subcontainer. 


8. Perform step two of the two-step Exmerge process to import the mail from the .pst files back into the individual mailboxes. 


NOTE : Test the directory import and export procedure on a recovery server first before you perform it on a production server. 

Exmerge.exe is available in Microsoft BackOffice Resource Kit version 3.0. The latest version is available from Microsoft Product Support Services that is located at Microsoft’s Web site

NOTE : Messages that are imported with Exmerge no longer have single instance storage. 

For additional information about directory import and export, the use of the Exchange Server 4.0 .csv files, the use of the Header.exe tool, and ExMerge.exe, click the article numbers below to view the articles in the Microsoft Knowledge Base: 

Q155414 XADM: Bulk Import/Export FAQ 

Q169761 XADM: Sample CSVs Not Included on Exchange Server 5.0 or 5.5 CD 

Q265441 XADM: Some Questions and Answers About the Exmerge Utility 

For additional information about how to move distribution lists between different recipient containers, click the article number below to view the article in the Microsoft Knowledge Base: 

Q258738 XADM: Moving Distribution List to Different Recipients Container 
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A.4
How to Re-home Public Folders Using 5.5 Admin Program (Q185043)


The information in this article applies to:


Microsoft Exchange Server, version 5.5 


SUMMARY

This article explains how to re-home public folders to a particular Exchange Server computer, using the Microsoft Exchange Server 5.5 Administrator program. 

In some situations, public folders may be accidentally re-homed to another site, and this article should help in recovering from such a situation. 

MORE INFORMATION

Microsoft Exchange Server 5.5 has a number of new features designed to help with public folder re-homing situations. The Microsoft Exchange 5.5 Administrator program can re-home individual public folders to any server that contains a replica of the public folder. All subfolders of the public folder can then be automatically re-homed as well. 

In order to re-home public folders using the Administrator program, you must be running the Exchange 5.5 Administrator program against an Exchange Server 5.5 computer. Also, this procedure assumes that you want the entire public folder sub-tree re-homed to the Exchange Server 5.5 computer. 

The steps below assume that all the public folders were initially homed in the site ORIGINAL_SITE and have been accidentally re-homed to the site NEW_SITE. The name of the Exchange Server 5.5 computer in ORIGINAL_SITE is SRVPF55. All folders under a folder called "NorthAmerica" need to be re- homed back to ORIGINAL_SITE, and it's okay to have a replica of these folders on server SRVPF55. 


1. If an Exchange Server 5.5 computer does not exist in site ORIGINAL_SITE, add a new 5.5 server to the site, or upgrade an existing Exchange Server 4.0 or 5.0 computer to version 5.5. Assume this 5.5 server is called SRVPF55. 


2. Run the version 5.5 Microsoft Exchange Administrator program against server SRVPF55. 


3. Get properties of the Public Information Store object. The Public Information Store object is found under <Site>\Configurations\Servers\<Server Name> 


4. Go to the Instances property page of the Public Information Store properties. 


5. Search for the NorthAmerica folder in the list labeled Public Folders. You may need to select the site NEW_SITE in the Site list. Use the Folder path to make sure that you have found the correct public folder. 


6. After you have found the NorthAmerica folder, select it and click the Add button. This moves the folder to the list labeled "Folders on this Information Store". 


7. Click OK to close the property sheet. 


8. Press the F5 key to refresh the Administrator program. 


9. In the Administrator program, under the organization object, click the Folders object to expand it. Then click Public Folder. You should see the Public Folder hierarchy. Traverse the hierarchy until you reach the NorthAmerica folder. 


10. Select the NorthAmerica folder. On the File menu, select Properties. This brings up the properties of the folder. 


11. Go to the Advanced property page of the folder properties. 


12. From the "Home server" list, select SRVPF55. 


13. Click OK to close the property sheet. This re-homes the NorthAmerica folder to the server SRVPF55. 


14. Wait for about a minute. 


15. Press F5 in the Administrator program to refresh the data displayed. 


16. In the public folder hierarchy, select the NorthAmerica folder. On the File menu, select Properties to bring up the properties of the folder. 


17. Go to the Replicas page of the folder properties. 


18. Check the list on the right labeled "Replicate folders to". This list should include SRVPF55. Remove from this list any servers that you do not want all of the subfolders of the NorthAmerica folder replicated to. 


19. After you have verified the replica list, go to the General page of the folder properties. 


20. Select the setting labeled "Propagate these properties to all subfolders". (If this setting is not visible, either you are not using an Exchange 5.5 Administrator program, or the folder whose properties you have obtained does not have any subfolders.) 


21. Click OK. This brings up a dialog box titled "Subfolder Properties". Clear all options except Replicas. 


22. After selecting only the Replicas option, click OK. This starts a process to automatically modify the replica list of all subfolders of the NorthAmerica folder, with the replica list of the NorthAmerica folder. This results in a replica of all subfolders being added to the SRVPF55 server. This process may take up to several hours, depending on the number of subfolders. After this process is completed, all the data in the public folders whose replicas were added will start being replicated to the SRVPF55 server. This is an important point if the only other replicas of the public folders are on servers across slow links. This process may cause very high network utilization on these slow links. 


23. After the process has completed, refresh the Administrator program by pressing the F5 key. 


24. Get permissions of the NorthAmerica folder again. 


25. On the General page, select the setting labeled "Propagate these properties to all subfolders". 


26. Click OK. This brings up the Subfolder Properties dialog box. Clear all options except Home Server. 


27. Click OK. This starts a process to re-home all the subfolders of the NorthAmerica folder to the SRVPF55 server. 


After this process has completed, all the subfolders will be re-homed to server SRVPF55. If the public folder permissions were lost during the accidental re-homing, this process does not restore the permissions. 

NOTE: The contents of all the subfolders will be replicated to the server SRVPF55. This may affect network utilization. 

NOTE: In order for you to perform the above steps, both the Administrator program and the server against which the Administrator program is running must be version 5.5. 

The server on which the public folders have been accidentally re-homed does NOT have to be running version 5.5. 

Advantages of using an Exchange Server 5.5 computer to re-home folders 

Using the Exchange 5.5 Administrator program in conjunction with an Exchange Server 5.5 computer has the following advantages over other methods, such as using PFADMIN.EXE, to re-home public folders: 


The amount of work needed to re-home entire public folder trees is greatly reduced. 


All the work is done on the original site and there is no need to access the server on which the folders were accidentally re-homed. This may be useful if the server where the folders are re-homed is across a slow WAN link. 


There is no need to add replicas of all folders to the server where the folders are re-homed. This eliminates the replication of the contents of all the public folders across a possibly slow network link. 


Considering these advantages--if an Exchange Server 5.5 computer is not available in the original site, it may be useful to install one in the site if you need to re-home public folders. 
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A.5
How To Export Public Folder Directory Data To A CSV File (Q185018)


The information in this article applies to:


Microsoft Exchange Server, versions 4.0 , 5.0 , 5.5 


SUMMARY

This article explains how to export the directory entries for Microsoft Exchange Server public folders. 

The Microsoft Exchange Administrator program does not export public folder data. In some cases, it may be useful to export the directory attributes associated with public folders to manipulate this data and then import it back. You can import the .csv file using the Exchange Administrator program. 

MORE INFORMATION

The Dsexport.exe utility, which is available in the Microsoft Platform Software Development Kit (SDK), can be used to export directory information about public folders. Dsexport.exe is located in the Samples\Dbmsg\Exchange\Dsexport directory. 

Dsexport.exe has some command-line arguments that are not recognized by the Microsoft Exchange Administrator Import\Export processor. It is these arguments that make this tool particularly useful for dumping objects other than mailbox or recipient container objects. 

For more information about Dsexport.exe, consult the Microsoft Platform SDK documentation. 

Using Dsexport.exe: 

Dsexport.exe outputs information into a text file as comma separated values (CSV). If the target file exists prior to running Dsexport.exe, and this target CSV file lists the name of each of the desired object attributes separated by commas, the file is used as a template header file when Dsexport.exe is executed. This provides the ability to control which object attributes are dumped. If the CSV file does not exist, the file will be created with 13 basic fields. 


1. Copy Dsexport.exe to the \Exchsrvr\Bin directory. 


2. In the \Exchsrvr\Bin directory, create a text file called PFlist.csv with only the following single line of text in it: 

      Obj-Class,Directory Name,Display Name,E-mail Addresses


You can add any other attribute you require to the above header line. 


3. Execute the following command-line (all on one line) from the \Exchsrvr\Bin directory: 

dsexport /FILE=PFLIST.CSV /DSA=%1 /BASEPOINT=/o=%2/ou=%3 /CLASSES=PUBLIC-FOLDER /HIDDEN /SUBTREE 
where: 

%1 = <local exchange servername> (Case sensitive) 
%2 = <organization name> (Case sensitive) 
%3 = <site name> (Case sensitive) 

This will result in a PFList.csv file that includes one line for each public folder in the site. 

In order to export a list of all public folders in the entire Exchange organization instead of for one particular site, use the following command line (all on one line): 

dsexport /FILE=PFLIST.CSV /DSA=%1/BASEPOINT=/o=%2/CLASSES=PUBLIC-FOLDER/HIDDEN /SUBTREE 
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A.6
Documentation for the NTDSNoMatch Utility (Q274173)


The information in this article applies to:


Microsoft Exchange 2000 Server 

Microsoft Exchange Server, version 5.5 SP3 


SUMMARY

This article explains how to install and use the NTDSNoMatch utility. It also describes the algorithm used by NTDSNoMatch. 

NOTE : The NTDSNOMatch utility is only available through Microsoft Product Support at this time. The NTDSNoMatch utility is also known as NTDSAtrb 

MORE INFORMATION

When you use the Active Directory Connector (ADC) to synchronize a Microsoft Exchange Server 5.5 organization with Active Directory, and you have multiple mailboxes with the same primary Microsoft Windows NT account, you can control how the ADC matches the mailboxes to Active Directory user accounts. 

In Microsoft Exchange 2000 Server, unlike Exchange Server 5.5, a mailbox is an attribute of an object in Active Directory, not an object itself. Therefore, each user object in Active Directory can only be matched to one mailbox. For every mailbox that exists in the information store, a matching object must exist in Active Directory. This difference allows you to retain the permissions set directly on the mailbox object, such as delegate and additional mailbox owner permissions. 

By default, the ADC creates disabled users in Active Directory if it cannot match a mailbox to a user. Additionally, a custom attribute can be set on the mailbox to force the ADC to create a new object instead of matching it to an existing user. To do this, set Custom Attribute 10 to NTDSNoMatch . When you set this attribute on resource-type mailboxes, ADC is able to match a mailbox that does not have the NTDSNoMatch option set to the correct user account. 

The NTDSNoMatch utility can be used to help perform this task. It checks for mailboxes with a duplicate primary Windows NT account, and determines if the mailbox is the primary mailbox or a resource mailbox. Then, it creates a comma-separated value (.csv) file, that you can import into the Exchange 5.5 directory. This file automatically sets Custom Attribute 10 to NTDSNoMatch for the resource mailboxes. 

Installing NTDSNoMatch 

NTDSNoMatch can be installed on any Windows 2000 computer. It does not need to be installed on the Exchange 5.5 server. To install the NTDSNomatch, copy the following files list below locally and then run Setup executable: 

Setup.exe 


Setup.lst 


Ntdsno1.cab 


The default install location of NTDSNoMatch is c:\Program Files\NTDSNoMatch. You can specify the install location during setup. 

Using NTDSNoMatch 

Before running NTDSNoMatch, check to make sure you meet the following prerequisites: 

1. NTDSNoMatch must be run from a Windows 2000 machine. The program will not run from Windows 9x or NT 4.0. 


2. Ensure the account you are using has permissions to read the Exchange 5.5 directory. 



Usage: ntdsnomatch <servername> where <servername> is the name of a 5.5 server in your organization. 

Use the following syntax if the Exchange server is using a port different than 389: 

NTDSNoMatch servername:port# 

NOTE : If the Windows 2000 machine that you are running NTDSNoMatch on, is not in the same domain as the Exchange 5.5 server, you can use the RUNAS command to launch a NTDSNoMatch with the proper credentials. Here is an example assuming that the account you want to use is EXCHDOMAIN\Administrator to connect to a server named EXCHSERVER. 

1. From a command prompt, navigate to the directory which contains ntdsnomatch.exe 


2. type the following: runas /user:EXCHDOMAIN\Administrator "ntdsnomatch EXCHSERVER" 


3. Enter the password when prompted and press ENTER 


4. You should see Attempting to start "ntdsnomatch EXCHSERVER" as user "EXCHDOMAIN\Administrator"... 


NOTE : If Windows Installer dialog box opens, you can safely click Cancel to continue operation. 

CSV Files Generated 

The output of NTDSNoMatch is a series of CSV files. A CSV file is created per site which can be directly imported into Exchange 5.5 Administrator. Each CSV file is named based on the site name, i.e Sitename.csv. In addition, a general NTDSNoMatch.CSV file is created for custom configurations. This file cannot be directly imported into Exchange 5.5, and requires manual editing. All CSV files will have an entry for every mailbox that has a duplicate Primary NT account. The mailboxes that were determined to be resource mailboxes will have Custom Attribute 10 set to "NTDSNoMatch". All CSV files are saved to the same directory as the NTDSNoMatch utility. 

NOTE : It is strongly recommended that you examine the CSV files carefully before importing into Exchange 5.5 to ensure the correct mailboxes are listed. The CSV files can be modified as necessary before importing. 

Description of the Algorithm used by NTDSNoMatch 

NTDSNoMatch does a simple check to determine whether to stamp NTDSNoMatch into Custom Attribute 10 on a mailbox. 

If the alias of the mailbox matches the Security Accounts Manager (SAM) account name, then the mailbox is considered to be the primary mailbox, and NTDSNoMatch is not stamped. If the alias does not match the SAM account name, then NTDSNoMatch is stamped on the mailbox. 

For example, if you have three mailboxes, a primary mailbox and two resource mailboxes, and all three mailboxes have a primary Windows NT account of Exchdomain\MailboxOwner, the following table tells you if NTDSNoMatch is stamped on the mailbox: 


	Mailbox Alias 
	SAM account name 
	Will NTDSNoMatch be stamped? 

	MailboxOwner 
	MailboxOwner 
	No 

	ResourceAccount1 
	MailboxOwner 
	Yes 

	ResourceAccount2 
	MailboxOwner 
	Yes 




If the ADC has already replicated and created disabled accounts in Active Directory, then the NTDSNoMatch utility can still be used to determine which mailboxes have duplicate primary Windows NT accounts, but you need to do additional cleanup work to ensure all mailboxes are matched properly. 

For additional information, click the article number below to view the article in the Microsoft Knowledge Base: 

Q256862 XADM: How to Correct Mismatched Accounts After ADC Replication 

NTDSAtrb (the new version of NTDSNoMatch) is on the SP1 CD in the support directory. 
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A.7
Readme Document for the Pfinfo.exe Program (Q261093)


The information in this article applies to:


Microsoft Exchange Server, version 5.5 


SUMMARY

The Microsoft Exchange Public Folder Information Program (PFInfo.Exe) is a program that extracts information about the Public Folders in a Microsoft Exchange Site. This information is saved into a delimited file, which can be viewed in a spreadsheet like Microsoft Excel. The data can then be manipulated in any way desired. PFInfo.exe can also generate a file, with information on public folder permissions and replicas, that can be used in conjunction with the PFAdmin.exe utility shipped in the BackOffice Resource kit. To use this file with PFAdmin.exe, you must have PFAdmin.exe, version 1.3 or higher. 

You can obtain the PFInfo.exe utility by calling Microsoft Product Support Services. 

COMMAND LINE OPTIONS 
==================== 

PFINFO.EXE supports the following command line options: 

-S Indicates that the program is being running from a service, like the Windows NT Schedule service. 

-LogMin Set the logging level to minimum 

-LogMed Set the logging level to medium 

-LogMax Set the logging level to maximum 

RUNNING THE PROGRAM 
=================== 

To run the program, double click on PFINFO.EXE from the Windows NT Explorer or File Manager. Select the desired output file and the separator to be used when writing data to the output file. 

To generate an import file for PFAdmin.exe, select the option, "Create file for use with PFAdmin.exe". By default this information is written to a file called PFAdmDat.txt. To change the filename as well as configure what information is written out to the import file,click the button labelled "Options". 

To start the program, click on the button labeled 'Start'. Now the program should list all the Microsoft Exchange profiles available on the local machine. Select a profile that has the Microsoft Exchange Server service listed and is configured with a mailbox on a server in the site from which you wish to extract Public Folder information. 

The program will now step through all the available Public Folders and extract data on these folders, writing this data to the specified output file. Any errors will be logged in the specified log file. It is recommended that you are logged into Windows NT as the Microsoft Exchange Service Account. 

To speed up operation of this program, it is recommended that you select the "Only extract data for public folders homed in the current site" option. This will cause the program to not try and connect to any folders that are not homed in the site it is connected to. This is the site containing the mailbox specified in the profile selected. Hence in order to extract information about all public folders in an Exchange organization, it is recommended that PFInfo.exe be run in each site. 

Version 3.1 and higher of PFINFO.EXE, supports the use of an .INI file. The program will read the settings in a file called PFINFO.INI, which should be present in the same directory as the executable. The .INI file, allows PFINFO.EXE to be run in batch mode, possibly in a scheduled manner. 

For more information on the INI file settings available, please refer to the INI file. 

USING PFINFO.EXE TO RECOVER LOST PUBLIC FOLDER PERMISSION 
=========================================================== 

In some circumstances, the permissions on all (or some) public folders in an organisation may be lost. In these situations, PFINFO.EXE can be used to easily recover public folder permissions. If a current version of the PFADMDAT.TXT file, created by PFINFO.EXE for use with PFADMIN.EXE, is available, this file can be imported to restore the permissions. This assumes that the file was created, before the loss of public folder permissions. 

If a valid PFADMDAT.TXT file is not available, follow the steps below: 

1) On a recovery server, install Microsoft Exchange Server. 

a) Select the option to create a NEW SITE. 
b) Use the same Organization and Site names as the production servers. 

2) Upgrade the server to the same service pack as the production server. 

3) Restore the Public Information Store, from Backup, onto the recovery server. 

4) DO NOT run the DS/IS Consistency Adjuster. If you do, you will lose all Public Folder permissions. 

5) Create a test user, on the recovery server. 

6) Install the Exchange client or Outlook on the recovery server. 

7) Create a profile for the test user created in step 5. 

8) Run PFINFO.EXE 

a) Do not select the option "Only extract data for public folders homed in the current site". 
b) Click on the Options button to display the PFAdmin Output File Option dialog. Make sure that the option to include Public Folder Permissions is selected. Click OK. 
c) Click on Start and select the profile created in step 7. 

9) Once PFINFO.EXE has completed, use the file PFADMDAT.TXT created by PFINFO.EXE, as input for PFADMIN.EXE 

REQUIREMENTS 
============ 
The program requires that the Microsoft Exchange client be installed on the machine on which it is run. The program also requires the following DLL files, most of which should be installed when you install the Microsoft Exchange Client and Administrator programs. 

ACLCLS.Dll 
ADVAPI32.dll 
COMCTL32.dll 
COMDLG32.dll 
GAPI32.dll 
GDI32.dll 
KERNEL32.dll 
LZ32.dll 
MAPI32.dll 
MFC42.DLL 
MPR.dll 
MSVCIRT.dll 
MSVCRT.dll 
MSVCRT40.dll 
NTDLL.dll 
OLE32.dll 
RPCRT4.dll 
SHELL32.dll 
USER32.dll 
VERSION.dll 

DATA EXTRACTED BY THE PROGRAM 
============================= 
The current version of the program will extract the following information to the delimited output file. 

1) Folder Name 
2) Folder Path 
3) Permissions 
4) List of Public Folder Replicas 
5) Number of Replicas of the Public Folder 
6) Number of Items in the Public Folder 
7) Size in KiloBytes of the contents of the folder, not including sub-folders 
8) Age Limit 
9) Replication Message Priority 
10) Replication Schedule 
11) Alias 
12) Storage Limit (K) 
13) Date the Public Folder was Created 
14) Date the Public Folder was last modified (As seen in the Exchange Administrator program) 
15) Home Site 
16) Home Server 
17) E-mail Addresses 

AUTOMATING THE EXTRACTION OF PUBLIC FOLDER INFORMATION, USING WINAT 
=================================================================== 

It is possible to run PFINFO.EXE in a batch process. This will allow the program to be run from a scheduler and hence it is possible to run the program every night to make a backup of the public folder permissions. This can be extremely useful in case of an emergency where all public folder permissions are lost, as explained above. 

To extract public folder information in batch mode, you must be running PFINFO, Version 3.5 or later. With this release the capability to read configuration information from an INI file was added to the program. This allows the program to be run without any user intervention, using the Windows NT AT Scheduler. 

Instead of using the Windows NT AT command to schedule a task from a command prompt, it is easier to use the WINAT.EXE program that uses to GUI to schedule tasks. The WINAT.EXE program ships in the Microsoft Windows NT Resource Kit. 

Running PFINFO.EXE using WINAT.EXE 
----------------------------------- 

1) Start the Windows NT Schedule Service. Use the Exchange Service Account as the startup account. If the Schedule service is started using the Local System Account, PFINFO.EXE will fail with a MAPI Logon Error. 

2) Set the following settings in the PFINFO.INI file. This file should be in the same directory as the PFINFO.EXE file. 

[PFINFO] 
ProfileName="Any Valid Profile" 

Where "Any Valid Profile" is a profile containing the Exchange Server service. The Exchange Server service should be configured with a server in the site that you wish to extract public folder data from, as well as a mailbox on the server specified. In addition to the above settings, you can also configure the names of the output files, log file and other settings using the .INI file. For more information on the INI file settings available, please refer to the section below. 

3) Run WINAT.EXE 

4) From the Edit menu, select Add. This will bring up the Add Command dialog. 

5) In the Command edit box, enter 

"Path"\PFINFO -S 

Where "Path" is the full path to the PFINFO.EXE file. 

The -S command line option specifies that the program will be executed from a service. If the -S option is specified, the program will execute without displaying any user interface and not wait for any user input. However, you must make sure that the ProfileName entry in the .INI file has a valid profile specified and that this profile is not configured for offline use. Otherwise the program will not be able to successfully perform a MAPI login and will fail. 

The -S option should only be specified when running PFINFO from the Windows NT Scheduler. When running PFINFO interactively (from a command prompt or Windows Explorer), the -S command line option should NOT be specified. When the -S command line option is specified, the program assumes that it is being called from a Service and initializes MAPI differently. 

6) Configure when you wish the program to be executed. 

7) Click on OK. 

8) Exit WINAT 

9) The Windows NT Scheduler will automatically execute PFINFO at the time specified and the output files will be generated in the locations specified in the PFINFO.INI file. 

Note: 
The INI file with all the configuration information must be present in the same directory as the executable and must be called PFINFO.INI 

TROUBLESHOOTING 
=============== 
The program generates a log that contains all errors that the program encounters. It also supports the following command line options that increase the amount of information logged. 

-logmin 
-logmed 
-logmax 

KNOWN ISSUES 
============ 
Error getting folder properties: Error E_FAIL - Unknown Failure "Folder Name" 
--------------------------------------------------------------- 
This error is noticed when trying there are no accessible replicas of the folder. The error may be noticed when a Public Store (PUB.EDB) is restored on a recovery server with a different name from the server from which the PUB.EDB was obtained. 

To resolve this problem, go to the Instances page of the Public Information Store on the recovery server and add an instance of every public folder to the local server. 

PFINFO.EXE crashes with a Dr. Watson dump 
----------------------------------------- 
Check the version of the ACLCLS.DLL file. The time stamp should be 1/15/96 or later. 
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A.8
Function and Effects of the DS/IS Consistency Adjuster [Q182979] 

PSS ID Number: Q182979
Article last modified on 09-16-2001 
The information in this article applies to:
 - Microsoft Exchange Server, versions 4.0, 5.0, 5.5 
SUMMARY
=======
This article explains the function and effects of running DS/IS consistency
adjuster. Because of the potential problems that the DS/IS consistency adjuster
may cause, Microsoft recommendeds that you contact Microsoft Product Support
Services (PSS) before you run it.
MORE INFORMATION
================
The DS/IS consistency adjuster is used in disaster recovery scenarios where it
is not possible to restore the directory to the recovery computer, or where the
information store (the Priv.edb or Pub.edb file) is copied to a recovery
computer with a name that is different from that of the original server.
The DS/IS consistency adjuster is run to re-create the directory objects for the
mailboxes and for public folders that are in the store and not in the directory.
This process also resets the Home-MDB attribute on all public folders in the
hierarchy that are homed on unknown sites or servers. In addition, the process
strips the public folder access control lists (ACLs) of any invalid entries
(that is, users who do not exist in the current directory). Servers and sites
are "unknown" and invalid entries exist when replication has not completed to
the server that the DS/IS consistency adjuster was run on or when a replication
connector to another site has been removed.
After the rehoming process is complete, if you re-create a replication connector
to the organization, there is a conflict for each rehomed public folder. The new
server wins the conflict because it has the latest changes to the public folders
in question. Accordingly, the public folder is homed on the new server, and the
new ACL is kept. This results in lost permissions for any users not on the site
where the DS/IS consistency adjuster was run.
The DS/IS consistency adjuster is modified in Exchange Server 5.5 and each of
these functions (making new directory entries for mailboxes, modifying ACLs in
mailboxes, rehoming public folders, and modifying ACLs in public folders) must
be selected manually to take effect. Additionally, a new attribute of public
folders in Exchange Server 5.5 is to "Limit Administrative Access" to a public
folder to a home site, which prevents other sites from being able to rehome
those particular folders. Note that this property is only fail-safe in an
environment that is completely Exchange Server 5.5. In a mixed version 4.0, 5.0,
and 5.5 Exchange Server environment, version 4.0 and 5.0 Administrator
Consistency Adjustment programs ignore the Administrative Access flag and rehome
the folders anyway.
NOTE: You do not need to run the DS/IS consistency adjuster if you only want to
restore an information store to a production server that has a good working
directory.
To run DS/IS consistency adjuster:
1. In the Exchange Server 5.5 Administrator program, click a server running
  Exchange Server 5.5 that contains a public information store.
2. On the File menu, click Properties, and then click the Advanced tab.
3. Click Consistency Adjustment.
4. In DS/IS Consistency Adjustment, select the Remove unknown user accounts from
  public folder permissions check box, and then select All inconsistencies.
NOTE: Clear all other check boxes.
Additional query words: exfaq 7037
======================================================================
Keywords          : kbusage 
Technology        : kbExchangeSearch kbExchange500 kbExchange550 kbExchange400 kbZNotKeyword2
Version           : :4.0,5.0,5.5
Issue type        : kbinfo
=============================================================================
Copyright Microsoft Corporation 2001.
Appendix B   MSFT White Papers

These excerpts are reproduced from MS white papers found in the public domain

B.1
Chapter 20 of the Windows 2000 Server Deployment Planning Guide.

The following describes the mapping that occurs between the Exchange 5.5 DS object classes and the AD schema.  

ADC Schema and Object Mapping

Each connection agreement uses a table-based schema map for the majority of attributes on objects synchronized between the two directories. The default map is located on the ADC policy object in Active Directory. While it is possible to enable and disable a subset of attributes synchronizing in either direction, it is not possible to modify the schema mapping from the ADC Administrator MMC snap-in. 

Tables 20.3, 20.4, 20.5, and 20.6 list many of the mappings defined in the default schema map. 

Table 20.3 defines the attribute mappings for all objects in Windows 2000 and Exchange. If an attribute value for an attribute to be mapped does not exist in the source directory, that mapping is ignored. 

Table 20.3 Attribute Mappings for All Objects 

	Windows 2000 Attribute (LDAP Name)
All Object Classes

	Exchange Attribute (LDAP Name)
All Object Classes


	description
	Admin-description

	autoReply
	AutoReply

	businessRoles
	Business-Roles

	co
	co

	company
	company

	delivContLength
	deliv-Cont-Length

	department
	department

	displayName
	cn

	displayNamePrintable
	name

	distinguishedName
	distinguishedName

	dnQualifier
	dnQualifier

	employeeID
	employeeNumber

	extensionAttribute1
	Extension-Attribute-1

	extensionAttribute2
	Extension-Attribute-2

	extensionAttribute3
	Extension-Attribute-3

	extensionAttribute4
	Extension-Attribute-4

	extensionAttribute5
	Extension-Attribute-5

	extensionAttribute6
	Extension-Attribute-6

	extensionAttribute7
	Extension-Attribute-7

	extensionAttribute8
	Extension-Attribute-8

	extensionAttribute9
	Extension-Attribute-9

	extensionAttribute10
	Extension-Attribute-10

	extensionAttribute11
	Extension-Attribute-11

	extensionAttribute12
	Extension-Attribute-12

	extensionAttribute13
	Extension-Attribute-13

	extensionAttribute14
	Extension-Attribute-14

	extensionAttribute15
	Extension-Attribute-15

	facsimileTelephoneNumber
	facsimileTelephoneNumber

	generationQualifier
	generationQualifier

	homephone
	homephone

	homePostalAddress
	homePostalAddress

	houseIdentifier
	houseIdentifier

	info
	info

	initials
	initials

	l
	l

	Language
	Language

	mail
	mail

	mailnickname
	uid

	mobile
	mobile

	otherTelephone
	Telephone-Office2

	otherHomePhone
	Telephone-Home2

	telephoneAssistant
	telephone-Assistant

	pager
	pager

	personalPager
	personalPager

	personalTitle
	personalTitle

	physicalDeliveryOfficeName
	physicalDeliveryOfficeName

	postalCode
	postalCode

	secretary
	secretary

	sn
	sn

	st
	st

	street
	street

	streetAddress
	postalAddress

	telephoneNumber
	telephoneNumber

	telexNumber
	telexNumber

	teletexTerminalIdentifier
	teletexTerminalIdentifier

	textEncodedORAddress
	textEncodedORAddress

	title
	title

	userCertificate
	userCertificate

	userCert
	user-Cert

	userSMIMECertificate
	userSMIMECertificate

	url
	url

	x121Address
	x121Address

	autoReplyMessage
	conferenceInformation

	importedFrom
	Imported-From


Table 20.4 defines the attribute mappings for all User objects and Mailbox objects in Windows 2000 and Exchange. 

Table 20.4 Object Class-Specific Mappings 

	Windows 2000 Attribute (LDAP Name)
User Object

	Exchange Attribute (LDAP Name)
Mailbox Object


	givenName
	givenName

	manager
	manager

	altRecipient
	Alt-Recipient

	publicDelegates
	public-Delegates

	mdbUseDefaults
	mdb-use-defaults

	mdbOverQuotaLimit
	MDB-Over-Quota-Limit

	mdbStorageQuota
	MDB-Storage-Quota

	submissionContLength
	submission-cont-length

	mDBOverHardQuotaLimit
	DXA-task

	protocolSettings
	protocol-Settings

	mapiRecipient
	mapi-recipient

	msExchHomeServerName
	home-MDB

	msExchHomeServerName
	home-MTA

	deliverAndRedirect
	deliver-and-redirect

	garbageCollPeriod
	garbage-coll-period

	securityProtocol
	security-Protocol

	deletedItemFlags
	DXA-Flags

	objectSID
	Assoc-NT-Account

	authOrig
	Auth-Orig

	unauthOrig
	Unauth-Orig

	dLMemSubmitPerms
	DL-Mem-Submit-Perms

	dLMemRejectPerms
	DL-Mem-Reject-Perms

	folderPathname
	Folder-Pathname


Table 20.5 defines the attribute mappings for Contact objects and Custom objects in Windows 2000 and Exchange. 

Table 20.5 Object Class-Specific Mappings 

	Windows 2000 Attribute (LDAP Name)
Contact Object

	Exchange Attribute (LDAP Name)
Custom Object


	givenName
	givenName

	Manager
	Manager

	targetAddress
	target-Address

	protocolSettings
	protocol-Settings

	mapiRecipient
	mapi-Recipient

	AuthOrig
	Auth-Orig

	UnauthOrig
	Unauth-Orig

	dlMemSubmitPerms
	dl-Mem-Submit-Perms

	dlMemRejectPerms
	dl-Mem-Reject-Perms


Table 20.6 defines the attribute mappings for Group objects and Distribution List objects in Windows 2000 and Exchange. 

Table 20.6 Object Class-Specific Mappings 

	Windows 2000 Attribute (LDAP Name)
Group Object:

	Exchange Attribute (LDAP Name)
Distribution List Object:


	member
	member

	msExchExpansionServerName
	home-MTA

	managedby
	owner

	oOFReplyToOriginator
	OOF-Reply-To-Originator

	reportToOriginator
	Report-To-Originator

	reportToOwner
	Report-To-Owner

	hideDLMembership
	Hide-DL-Membership

	authOrig
	Auth-Orig

	unauthOrig
	Unauth-Orig

	dLMemSubmitPerms
	DL-Mem-Submit-Perms

	dLMemRejectPerms
	DL-Mem-Reject-Perms


Base your determination of the number of connection agreements your organization requires on your unique network environment, including your deployment objectives and requirements and your expectations for the outcome of implementation. You must also familiarize yourself with the Exchange Server and Active Directory object attributes that you are not able to synchronize. These attributes are listed in Table 20.7. 

Table 20.7 Attributes of Objects That Do Not Synchronize 

	Windows 2000 Server Active Directory

	Exchange Server 5.5 Directory Service


	All account information, such as Account Logging, Account Password, and so on
	Advance Security Settings

	Profile information
	Access Control Lists (ACLs)

	Routing and Remote Access dial-up permissions
	Home information Store

	Access Control Lists (ACLs)
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